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Introducció 
 

KyPlot és un entorn integrat per a l’anàlisi i la representació de dades. Mitjançant KyPlot es 
pot realitzar l’anàlisi de dades recollides a manera de full de càlcul, usant una àmplia varietat de 
mètodes estadístics i matemàtics. També permet representar de forma gràfica les pròpies dades i 
els resultats de les anàlisis. 

Es tracta d’una finestra compatible amb fulls de càlcul d’Excel, que suporta càlculs formulats 
en les cel·les de dades. KyPlot proporciona mètodes de computació com ara: optimització 
matemàtica, anàlisi espectral, etc. A més ofereix una gran varietat de procediments estadístics, 
incloent-hi tests tant paramètrics com no paramètrics i anàlisis multivariades. 

Es poden crear gràfics i completar-los amb anotacions pròpies. KyPlot permet: personalitzar 
cada aspecte d’un gràfic, fer ajustos lineals, no lineals, interpolacions, etc. 

Sobre KyPlot 
 

KyPlot és un programa de Koichi Yoshioka, d’ús lliure fins a la versió 2 Beta 15. Per aquest 
motiu resulta idoni perquè els estudiants de titulacions científiques i tècniques es familiaritzen 
amb el tractament de dades inherent al treball experimental i amb els estàndards propis del 
context científic. 

Sobre aquesta guia 
 

Alguns aspectes bàsics d’aquesta guia s’han extret de la pàgina web 
http://www.kyenslab.com/en/support/graph/index.html, mentre que la major part –en particular 
els més específics de l’anàlisi de dades científiques (ajustos de gràfics)– són originals. 
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Full de càlcul 

Importar dades 
Les dades es poden importar des de fitxers de text estructurats en columnes amb separadors 

(coma, punt i coma, etc.), igual com en altres programes anàlegs.  

Creació de taules de dades 
És una manera d’introduir les dades experimentals de forma guiada. Quan es fa ús d’aquesta 

opció (Data>Create Data Table), apareix un diàleg en què podem triar una plantilla, de les 
disponibles, per introduir les dades al full de càlcul de forma estructurada.  
 

 

 
Els valors que es poden triar per a la variable X són: 

 “Same X”: estableix una columna on s’introduiran les dades experimentals per a la 
variable X. 

 “Same X, Constant Interval”: igual a l’anterior, però ara els valors X seran omplerts 
a partir d’un valor inicial i l’increment. 

 “XY Pairs”: per agrupar per parells, de manera que hi haja tantes columnes X com 
sèries Y. 

Els valors que es poden triar per a la variable Y són: 
 “Y (Direct Input)”: perquè els valors de la variable Y siguen exactament els 

introduïts. 
 “Y (Indirect Input)”: perquè els valors de la variable Y siguen exactament els 

introduïts si s’ha introduït un nombre; en un altre cas no té efecte. 
 “Cumulative”: els valors es van acumulant, sempre que el valor introduït siga 

nombre. 
 “Proportion”: El valor resultat és proporció del total de valors. 
 “% Proportion”: igual a l’anterior però en tant per cent. 
 “Mean”: el valor resultat és la mitjana d’una sèrie de valors. 
 “Mean, Std error of Mean”: igual a l’anterior però el resultat inclou l’error 

estàndard de la mitjana. 
 “Mean, Standard Deviation”: els valors Y són la mitjana i la desviació estàndard 

dels valors obtinguts experimentalment. 
 “Mean, Max-Mean, Mean-Min” 
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 “Mean, Max, Min” 
 

Una vegada triat el tipus de dada per a Y, s’especifica el nombre de sèries que es volen per a 
Y, així com totes les repeticions per sèrie que es requereixen. La nova taula de dades es pot 
generar en un full nou (Output-New Spread) o en l’actual (Output-Current Sheet) a partir d’una 
determinada cel·la (Starting Cell). Una vegada fets aquests passos, només falta omplir les dades 
tant per a X com per a les sèries Y. 
 

 

 

Tipus de dades i formats 
Seleccioneu Format >Cell 

>Object i apareixerà una finestra 
en què podeu triar el tipus de dada 
de cada columna i/o els grups de 
cel·les (que haureu seleccionat 
prèviament). 

És possible triar el tipus de 
nombre i el nombre de xifres 
decimals que vulgueu visualitzar 
(vegeu “Format dels nombres dels 
eixos”, p. 12). 

En importar fitxers, és possible 
veure tots els decimals que figuren 
en les cel·les seleccionant All > 
General 

 

 

Generació de valors igualment espaiats 

En alguns casos cal generar una sèrie de dades igualment espaiats (normalment, la coordenada 
X, com el temps transcorregut a l’hora de mesurar o el voltatge aplicat…).  

En comptes de fer-ho a mà, KyPlot té una funció per generar aquestes dades. Per accedir-hi, en 
el menú “Edit”, seleccioneu “Fill” i “Fill Range” (vegeu figura següent): 

- En “X Series type” podeu seleccionar que la sèrie siga lineal o quadràtica. Si voleu valors 
igualment espaiats, serà lineal. 

- En “Menu” selecciona “Create X series”. “Calculate Formula F(X) (X: selected range)” serveix 
per calcular –una vegada seleccionats uns valors com a X–  la funció donada en “Input Formula” 
d’aquestes X. La tercera opció combina les dues primeres, crea la sèrie de dades i les usa com a 
X per calcular la F(X). 
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- “En X Sèries Range” hi ha diverses opcions per crear la sèrie. “Fill the selected Range” 
emplena totes les cel·les que hàgeu seleccionat amb la sèrie. “Fill to the End Value” crea la sèrie 
fins que arribe al “End Value” que li indiqueu. “Fill the Specified Range” crea el nombre de 
punts que li indiqueu. En tots els casos heu d’indicar el nombre inicial de la sèrie en “Start 
Value” i la diferència entre cada nombre de la sèrie en “Step Value”. 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Operacions amb cel·les 
Per fer operacions amb cel·les, podeu procedir amb l’“estil Excel”, que és fa escrivint 

directament la fórmula en una cel·la fent referència a altres cel·les i arrossegant aquesta fórmula 
a altres cel·les; o bé a l’“estil Kaleida”, que és fa indicant operacions entre grups de cel·les. 
Exemple: Es disposa de les dades següents, 

 
 

I volem dividir les dades de la columna B entre els de la columna A, posant el resultat en la 
columna D. 
 “Estil Excel”, escrivim en la cel·la D1 “=B1/A1”, seleccionem la cel·la D1 (que ja ha de 

mostrar el resultat de l’operació), cliquem en el quadre negre de la cantonada inferior dreta 
de la selecció i arrosseguem cap avall fins a la cel·la D7. Això arrossegarà la fórmula a totes 
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les cel·les fins a la D7 canviant el número de la fila pel que corresponga (és a dir, en D2 
quedarà “=B2/A2”, en D3 “=B3/A3”…). 
 

 
 

Nota: Per evitar que, en arrossegar la fórmula, canvie la fila o la columna d’alguna cel·la de la 
fórmula, col·loqueu en la fórmula un “$” davant la fila i/o la columna que no s’ha de canviar en 
arrossegar la fórmula. Exemple: per multiplicar la columna de dades d’abans el valor de la cel·la 
F3, si posem en D1 “=B1*F3” i arrosseguem la fórmula cap avall, en la cel·la D2 posarà 
“=B2*F4”, en la D3 “=B3*F5”… En canvi, si escrivim en D1 “=B1*F$3”, en arrossegar, en D2, 
quedarà “=B2*F$3”, en D3 “=B3*F$3”…, com volíem. 
 

 
 “Estil Kaleida”: en el menú “Data”, opció “Transform…” podeu realitzar operacions sobre 

un grup de dades (de primer seleccioneu el grup de cel·les que contenen les dades). Les 
cel·les d’eixida s’indiquen al programa en l’opció “Output Starting Cell”, mentre que 
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l’operació per realitzar es troba en “Transform”; el “Output as” t’indica si el resultat són 
directament nombres, o bé una fórmula (el resultat de la qual varia instantàniament si canvieu 
les dades). 
 
Per realitzar operacions entre diferents grups de dades, en el menú “Math” seleccioneu 
“Matriu/Vector Operation…” La finestra és anàloga a la de “Transform…” llevat que li 
podeu indicar els grups de dades en “Input Matrix/Vector A” i “Input Matrix/Vector B”. 
 

 

Creació de gràfics 
Per crear un gràfic, cal seleccionar en el full de càlcul les dades que voleu representar. 

Després, a través de l’opció de menú (Graph>Create Graph), o opció equivalent en la barra 
d’eines, s’obre el quadre de diàleg associat a la creació d’un gràfic. 

En el diàleg que apareix triem quin tipus de dada és X (X Data Type) i indiquem també quin 
tipus de dada és Y (Y Data Type). Tots dos tipus de dades normalment han de coincidir amb les 
donades en crear la taula de dades. A més podeu representar l’error estàndard (Y&Error/bubble), 
els errors màxim i mínim (Y&±errors) i els valors màxim i mínim Y, (Hi & Lo). En la zona 
inferior del quadre de diàleg veiem les dades que el programa interpreta com a X, Y, etc. 
Naturalment, els valors que contenen aquestes cel·les han de coincidir amb les columnes 
corresponents de la selecció realitzada prèviament. Per exemple, X(Col) és la columna B de la 
taula de dades, Y és la columna C per a “Control – Serie 1” i és la columna Y per a “Inhibitor-
Serie 2”. 
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El quadre de diàleg també permet afegir noves sèries, esborrar sèries existents, intercanviar X 
per Y, invertir l’ordre de les sèries, etc. Una vegada decidit el que voleu representar, cliqueu en 
“OK”. Apareix un altre diàleg on podeu especificar el tipus de gràfic (gràfic de línies, barres, 
radar, etc.), i configurar les seues opcions (els textos del gràfic, el títol del gràfic, el títol de l’eix 
X, el títol de l’eix Y), amb la possibilitat de seleccionar com a títols els situats en la taula de 
dades activant l’opció “Sheet” i establint la cel·la adequada. Finalment, aquest diàleg permet 
establir algunes opcions per al gràfic com poden ser: 

- ombres en dades i eixos 
- retallada de dades a l’àrea dibuixada (Clip data to plot area) 
- actualització del gràfic quan alguna dada canvie 
- ordre dels símbols utilitzats per a representar dades pel que fa als components del gràfic 

(eixos i línies de graella). 
 

 
Una vegada realitzats els ajustos 

desitjats premem una altra vegada 
“OK” per a obtenir el gràfic. 
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Format de gràfics 

Presentar múltiples gràfics en un mateix full 
El primer que pregunta el programa a l’hora de crear un gràfic és si es vol crear el gràfic en un 

full nou (“Figure”) o en una de ja creat. Aquesta última opció us permet presentar diversos 
gràfics simultàniament en el mateix full, només heu de seleccionar l’arxiu on vulgueu afegir el 
nou gràfic. 

 

 
 

Format d’eixos 
 
En la pàgina de figures seleccioneu un gràfic fent clic en la seua àrea o bé pitjant la tecla 
“TABULADOR”. 
Una vegada realitzada aquesta selecció, utilitzeu l’opció de menú Graph>X Axis>Set o feu doble 
clic prop de l’eix X en el gràfic; o seleccioneu l’eix X del gràfic i cliqueu en el botó “Propietats” 
en la barra d’eines. D’aquesta maneraa apareixerà el diàleg de configuració de l’eix X del gràfic. 

Mitjançant aquest diàleg ajusteu els 
eixos X i Y a les seues necessitats, 
canviant l’escala (en l’exemple, 
escala logarítmica) i el seu interval 
(en l’exemple, 0.0007 -- 0.7), el 
format de línia, etc. En la pestanya 
“Minor Tick Mark” –figura 
següent– s’indica el tipus de marca 
menor (en el nostre exemple, Log: 
3, 30…), quantes divisions hi ha 
d’haver per cada marca major (2 en 
l’exemple) i al costat configurem el 
tipus de línia i si volem que isca de 
l’eix cap a fora (Out) o entre cap a 
dins del gràfic (In) o tots dos 
(marcant tant In com Out). 

Els “Minor Tick Marks” són els punts de l’eix X/Y que no tenen associat un valor visible. Per 
contra, els “Major Tick Marks” són els punts de l’eix X/Y que tenen associat un valor visible en 
el gràfic. 
 
De la mateixa manera que hem configurat la pestanya “Minor tick Mark”, es configura la 
pestanya “Major Tick Marks”. En aquest cas seleccionem (en Select) “Single” i afegim fins a 
disposar de 4 punts en l’eix X. Donant al punt 4 de l’eix X el valor 0.5 [en “Major Tick Position 
(Single)]. 
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Una vegada realitzats els ajustos necessaris, cliqueu en “OK” perquè tinguen efecte en el gràfic 
seleccionada. 
  
 
 

 
 
 
 
 
 
 

 
 

 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

Introduir eixos addicionals 
Seleccioneu un eix, feu clic amb el botó dret i apareixerà “Set properties”. En la cantonada 

superior esquerra eixirà marcat “Left/Bottom Axis” (segons que hàgeu seleccionat l’eix esquerre 
o l’inferior); clicant en “Right/Top Axis”, accedireu a les propietats de l’eix dret/superior; i 
marcant l’opció “Show Right/Top Axis”, apareixerà. La configuració és idèntica a la dels eixos 
esquerre o inferior, i hi podeu indicar que aplique la mateixa configuració marcant “Right/Top 
Styles = Left/Bottom Styles”. 
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Canviar l’interval de marques grans (nombres) en els eixos 
Seleccioneu un eix, feu clic amb el botó dret i apareixerà “Set properties”. Cliqueu en la 

pestanya “Major Tick Marks”, marqueu “Custom, All” i en “Interval” escriviu l’interval desitjat 
entre marques grans de l’eix (i, per tant, entre nombres). 

 

 
 

Canviar el nombre de marques petites entre las grans 
Seleccioneu un eix, cliqueu amb el botó dret i apareixerà “Set properties”. Cliqueu en la 

pestanya “Minor Tick Marks”. Canvieu el valor de “Divisions per Mayor Tick”. Si el que voleu 
és que no apareguen, desseleccioneu tant “In” com “Out” en “Direction” (en la mateixa 
pestanya). 
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Format dels nombres dels eixos 

Seleccioneu un eix, feu clic amb el botó dret i “Set properties”. Cliqueu en “Labels”. 
Per canviar la grandària o la font, en la pestanya “Format” clica en “Font” (baix a l’esquerra). 
Per canviar la presentació dels nombres (decimals, exponents, etc.), en la pestanya “Format” 
cliqueu en “Set Format” i “Custom”: 

• Perquè apareguen n decimals, escriviu “0.” seguit de n “0”. Ex.: cinc xifres decimals s’escriu 
“0.00000”. 

• Perquè apareguen exponencials, simplement afegiu “E+” seguit de tants “0” com xifres vulgues 
que figuren en l’exponent. Ex.: volem que aparega amb un decimal i dues xifres en l’exponent, 
“0.0I+00”, el nombre 27 es mostra “2,7E+01”. 

• Si volem que figuren més xifres significatives a l’esquerra de la coma, hem d’afegir “#” a 
l’esquerra del “0.”. Ex.: “#0.0E+0” mostra el nombre 27 així: “27,0E+0”. 
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Format de les línies de la graella 
Seleccioneu un gràfic i obre el diàleg “PlotArea/Grids” en l’opció de menú Graph>Plot 

Area/Grids. En aquest exemple afegirem una línia de graella horitzontal sobre el nivell de control 
màxim (9.85). Per fer-ho, de primer cal modificar la configuració de l’eix Y per afegir-hi un nou 
punt (el 12) i li donem el valor 9.85 (vegeu com fer això en l’apartat anterior). Una vegada 
realitzat, obrim el diàleg “PlotArea/Grids” com s’ha esmentat i en la pestanya “Major Grids” 
seleccionem l’opció “Show Y (Horitzontal) Major Grids”. Després, en “Y (Horitzontal) Major 
Grids” seleccionem “all” i establim el seu tipus a “no line”. D’aquesta manera evitem que es veja 
una línia per cada marca major de l’eix Y. 
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Després seleccionem “single”, triem el punt 12 (el valor del qual ha de ser 9.85) i 

especifiquem el tipus de línia com a  “Solid/Dotted”. 
 

 
 
Finalment cliquem en 

“Apply” o “OK” perquè 
tinguen efecte els canvis. 
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Etiquetar eixos 

Una vegada seleccionat un gràfic, utilitzeu l’opció de menú Graph>X (o Y) Axis>Labels, o 
feu doble clic en el eix X o Y, mentre manteniu pitjada la tecla Control. Apareixerà un quadre de 
diàleg com el següent: 

 
 

Podeu canviar la unitat de 
mesura. En la pestanya “Location” 
seleccioneu l’opció “Custom” i 
poseu el valor inicial i l’increment. 
També podeu afegir una etiqueta al 
valor enèsim d’una mostra de 
dades, per exemple, escriure 
“Màxim: 9.85” sobre el valor 
nombre 12 representat sobre l’eix 
Y (en la pestanya “Location” 
podreu definir el desplaçament 
d’aquesta etiqueta respecte de l’eix 
X i Y). 
 
Tot això ens donarà com a resultat 
el gràfic següent  :  
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Editar títols 
És possible modificar els títols dels eixos X i Y de qualsevol gràfic. Feu doble clic en el títol 

actual. Apareixerà un editor de text. Modifiqueu el text al vostre gust i tingueu en compte la 
possibilitat d’escriure símbols grecs, etc. 
 

 
 

Girar objectes (com un títol d’eix) 
Seleccioneu l’objecte que voleu girar, cliqueu en la pestanya Transform (és l’última de les 

pestanyes que hi ha a l’esquerra del tot) i cliqueu en els símbols de gir, o bé en el menú 
“Arrange”, seleccioneu “Rotate/Reflect” i el gir desitjat. 
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Símbols per a les dades 
Seleccioneu el gràfic i cliqueu en l’opció de menú Graph>Data>Symbols. En el diàleg que 

apareix seleccioneu “All” en “Select Symbols”. Després, podeu triar el tipus de símbol desitjat 
per a la sèrie de dades. 

 

 
 
Una vegada realitzat això, seleccioneu l’opció “Series” en “Select Symbols” i configureu les 

propietats del símbol per a aquesta sèrie. Repeteix el procés per a la resta de les sèries de dades 
(si n’hi ha). 
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Format de “llegendes” o inscripcions 
 

Seleccioneu el gràfic i 
accediu a l’opció de menú 
Graph>Leyend. En el quadre de 
diàleg que apareix, feu els 
ajustos desitjats per a les 
llegendes que es mostraran en el 
gràfic. Finalment, prem “OK”. 

 
 
 
 
 

 

 

 

Guardar el format com a predeterminat 
És possible guardar el format d’un grup d’elements (eixos, títols, graella, etc.) del gràfic com 

a predeterminat, així el programa utilitzarà aquesta configuració per a aquest mateix element de 
tots els futurs gràfics que es creen. Per guardar la configuració com a predeterminada, clica en el 
botó “Save” situat baix a la dreta de la finestra de configuració de l’element en qüestió, i clica en 
“Accepta” en el menú de confirmació. 
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Copiar gràfics a Office 

Els gràfics es poden copiar en fitxers d’editors de text o ppt, simplement seleccionant tot el 
gràfic amb el punter i pitjant Ctrl C i Ctrl V en el document on voleu copiar. En alguns casos, la 
imatge pot eixir retallada. En cas que passe això, heu d’utilitzar l’eina de retallada d’imatge 
per recuperar la imatge original.  

També és possible exportar la imatge: en el menú “File” seleccioneu “Export...” i escriviu el 
nom de la imatge on es guardarà el gràfic. En la finestra següent que apareix (“Export Options”) 
es marca l’opció “Use KyPlot’s proper routine” i cliqueu en OK. Si hi ha cap problema a l’hora 
d’exportar les figures, en la finestra “Export as File” trieu un altre format diferent a “Windows 
Metafile (*.wmf)”. Per exemple, “Enhanced Metafile (.*emf)”. Ara, per portar-la a qualsevol 
programa de Office, cal importar-la. Això es fa en el menú “Inserir”, seleccioneu “Imatge” i 
després “Des d’arxiu...” 
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Ajust de dades experimentals 
Per ajustar una sèrie de punts a una funció, seleccioneu el gràfic de la qual vulgueu realitzar 

l’ajust, cliqueu en el menú “Graph” i seleccioneu “Fit”. 
Seleccioneu la funció a la qual vulgueu ajustar en “Formula”. Apareixerà una breu descripció 

de la funció en el quadre blanc de la dreta. Cliqueu en “Apply Fit” i KyPlot calcularà i dibuixarà 
l’ajust triat. 

  

 
 

Es poden fer diversos ajustos sobre el mateix gràfic. Si en voleu crear un de nou, cliqueu en 
“New Fit”. Per canviar entre un ajust i un altre, canvieu el nombre de “No.:”. Si voleu eliminar 
un ajust, seleccioneu el nombre corresponent i cliqueu en “Delete Fit”. 
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Full de resultats estadístics 
Per obtenir els resultats de l’ajust (valors, errors, coeficient de correlació), dins la finestra 

d’ajust, punxa en “Statistics”: 
 

 
 

Apareixerà una finestra com la següent amb tota la informació: 
 

 

Valors dels paràmetres Errors dels paràmetres 

R2 
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Funcions d’interès i el seu arxiu en KyPlot 

Exponencials 
Y=A1*(1-EXP(-A2*X)) Expass1.fun 
Y=A1*(1-EXP(-A2*(X-A3)))+A4 Expass1o.fun 
Y=A1*EXP(-A2*X) Expdec1.fun 
Y=A1*EXP(-A2*(X-A3))+A4 Expdec1o.fun 
Y=A1*EXP(A2*X) Expgro1.fun 
Y=A1*EXP(A2*(X-A3))+A4 Expgro1o.fun 
Y=EXP(A1+A2*X+A3*X^2) ExpQuad.fun 
Y=A1*10^(-A2*X) P10dec1.fun 
Y=A1*10^(A2*X) P10gro1.fun 
Rectes 
Y=A1*X Linereg0.fun 
Y=A1+A2*X Linereg.fun 
Polinomis 
Y=A1+A2*X+A3*X^2 Quadreg.fun 
Y=A1*X+A2*X^2 Quadreg0.fun 
Y=A1+A2*X+A3*X^2+A4^3+A5^4+... Multiline.fun 
Gaussianes 
Y=EXP(-(((X-A1)/A2)^2)/2) 
/(SQRT(2*PI)*A2) 

Normald.fun (Gaussiana d’àrea unitat) 

Y=A3*EXP(-(((X-A1)/A2)^2)/2) 
/(SQRT(2*PI)*A2) 

Normalda.fun (Gaussiana d’àrea A3) 

 

Introduir funcions noves  
Per ajustar a una funció nova, en la finestra d’ajustos cliqueu en “New”. Seleccioneu el 

nombre de paràmetres per ajustar en “# Parameters” i escriviu la funció per ajustar en la primera 
cel·la de la columna “Formula”. 
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Podeu guardar la funció creada clicant en “Save” i la tindreu disponible en els pròxims 
ajustos. 

 

 
 

Paràmetres inicials 
El programa té l’opció d’introduir els paràmetres inicials que utilitzarà per fer l’ajust. A 

vegades, això és absolutament necessari perquè el programa puga realitzar amb èxit l’ajust. 
Aquests paràmetres inicials han de ser el més pròxims possibles als valors que millor ajusten la 
corba, per això l’ideal és tenir una estimació o conèixer l’ordre de magnitud. 
Per defecte, el programa utilitza l’1 com a paràmetre inicial per a tots els valors. Es pot canviar 
en la columna A-Value de la finestra d’ajustos. 
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Lligadures en l’ajust 
KyPlot permet que definiu lligadures entre els paràmetres de l’ajust. Seleccioneu el nombre 

d’igualtats i desigualtats que voleu fixar en “# Inequalities” i “# Equalities”. Cliqueu en “Edit” i 
escriviu les lligadures en “Eq.=0” o “Ineq.>=0”, com corresponga, tenint en compte que la 
primera cel·la de cada columna correspon a la primera igualtat o desigualtat i així 
successivament. 

 
 

 
 
Dos dels casos més comuns a l’hora de realitzar lligadures són exigir que tots els paràmetres 

de l’ajust siguen positius, o que la suma de tots els paràmetres siga la unitat. Hi ha dos botons 
que fan directament aquestes lligadures: “All>=1” i “Sum=1”. 

En el cas de “All>=1”, tots els paràmetres es col·loquen en la columna d’inequacions indicant 
que tots han de ser positius. 

En el cas de “Sum=1” apareix una única equació que indica que la suma de tots els paràmetres 
menys la unitat és igual a zero. 
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Ajust de diversos conjunts de dades en el mateix gràfic 
Per ajustar dos o més conjunts de dades representades en el mateix gràfic, només has de 

seleccionar la sèrie de dades adequada per a cada ajust. Per canviar la sèrie de dades sobre la 
qual feu l’ajust, canvieu el nombre en l’apartat “Series” de la finestra d’ajustos. 
 

 
 

Representar funcions analítiques sobre un conjunt de dades 
Per representar una funció analítica, de primer feu clic en el gràfic en què vulgues pintar la 

funció i després clica en “Fit”, com si anàreu a fer un ajust. En l’opció “Menu” selecciona 
“Function Fit”. 

Es pot pintar en forma Y=F(X) o bé en forma paramètrica X=F(T), Y=G(T). En tots dos 
casos, el límit inferior i el superior en X (o en T) s’han d’escriure en la primera i la segona cel·les 
de la columna “X Range” (o “T Range”), respectivament. 

En el cas Y=F(X), F(X) s’ha d’escriure en la primera cel·la de la columna “F(X)”. En el cas 
paramètric, F(T) i G(T) s’escriuen en la primera i segona cel·les de la columna “F(T)/G(T)”, 
respectivament. Finalment, cliqueu en “Apply Fit”. Podeu configurar el format de la 
representació clicant en el botó “Fit Patterns”. 
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Canviar l’interval de la corba de l’ajust 
Per defecte, la corba de l’ajust va des del primer punt experimental fins a l’últim, però és 

possible canviar-ho. Per fer-ho, en la finestra de l’ajust cliqueu en “Range”, desmarqueu l’opció 
“Acte” i establiu els valors inferior i superior de l’interval desitjat. 
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Exemple de dos ajustos en un mateix gràfic 
Disposem de dues sèries de dades amb un mateix X (la columna A) per representar i ajustar en el 
mateix gràfic. Seleccionem les dades, cliquem en “Create Graph” i seleccionem les opcions per 
crear el gràfic: veiem que es tracta d’una exponencial decreixent i d’una funció sinusoïdal. 
 

 
 

Començarem amb l’ajust de l’exponencial (columna B, sèrie de dades 1). Cliquem en “Fit” i 
ens assegurem que es tracta de l’exponencial (ho podem comprovar amb les dades que figuren en 
la columna Y1 o perquè està seleccionada la sèrie 1). Cerquem l’exponencial adequada 
(Expdec1.fun. Cal fer notar que té una inequació que exigeix que el paràmetre A2 siga sempre 
positiu, obligant que l’exponencial siga sempre negativa) i apliquem l’ajust. 
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L’ajust es realitza correctament: 
 

 
Ara farem l’ajust de la funció sinusoïdal. De primer cliquem en “New Fit” per no 

sobreescriure l’ajust de l’exponencial. Després seleccionem la sèrie de dades 2 i creem un nou 
ajust a una funció F(X) = A1*COS(A2*X+A3). Exigim que A1 i A2 siguen positius a través 
d’inequacions. 
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L’ajust no ha tingut èxit: 
 

 

 
 

Hem de modificar els valors inicials de l’ajust, podem estimar fàcilment l’amplitud de la 
funció sinusoïdal, aproximadament ha de valdre A1=5. Repetim l’ajust eliminant el paràmetre 
A1 per obtenir així el valor aproximat dels altres dos. L’equació per ajustar quedaria: 
F(X)=5*COS(A1*X+A2). Hem d’eliminar la inequació sobrant i reajustar el nombre de 
paràmetres. 
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L’ajust torna a fallar: 

 
 

Veiem que la freqüència de la sinusoide (ara A1) resultant de l’ajust és major que la de les 
dades, per la qual cosa provem ara amb la meitat (en comptes d’1, que és el que ix de l’ajust 
fallit, posarem 0.5 en els valors inicials): 
 

 
 

Per fi s’ajusta a les nostres dades. Ara tornem a deixar lliure el paràmetre de l’amplitud, però 
utilitzem els valors inicials per fer l’ajust. És a dir, ajustem a la funció  A1*COS(A2*X+A3) 
amb valors inicials A1=5, A2=0.62 i A3=0.24: 
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S’ajusten amb èxit i ens dóna els valors més pròxims dels nostres paràmetres: 
 

 
  

 


